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01. The Core Problem: Schedules Are Constantly Revised

Every time a schedule is updated, the original baseline logic is masked or destroyed.

Delay analysis becomes impossible without a way to 'see through' the revisions.

Float Manipulation

Schedulers add float by 
reducing durations or logic, 

disguising real delays

Logic Changes

Predecessor/successor links 
are revised to show 
schedule recovery

Scope Changes

New activities are inserted to 
absorb delays without 

acknowledgment

Baseline Drift

The original CPM logic is 
progressively eroded 

through updates
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02. The Core Problem: Float Manipulation

The contractor's update lands on 
your desk. The critical path now 
shows 18 days of total float. Last 
month it showed 3 days. Nothing on 
site has changed no extra 
resources, no acceleration, no 
recovery plan submitted.

Your PM comes to you and says: "The 
schedule is showing us 3 days float 
that's too tight, it'll panic the client. 
Can you find some float in there?" 
You reduce a few activity durations 
by 10%, remove a finish-to-start lag. 
Done now it shows 18 days.

YOU ARE THE PM

W H A T  J U S T  H A P P E N E D

WH A T  J US T  H AP P E N ED

YOU ARE THE PLANNER

WHAT JUST HAPPENED

▸  No actual work was done faster. The project is still the same number of days late.

▸  The float didn't come from productivity — it came from compressing durations on paper.

▸  The PM reports to the client: 'We have 18 days of float — we're comfortable.' That is a false picture.

▸  When the delay eventually surfaces, it looks sudden and unexpected — when in fact it was always there.

Your work package shows 18 days 
float with nothing changed in your 
scope you're being held to a forecast 
you never agreed to

YOU ARE THE CAM
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03. The Core Problem: Logic Changes

  YOU ARE THE PLANNERYOU ARE THE PM

W H A T  J U S T  H A P P E N E D

WH A T  J US T  H AP P E N ED

YOU ARE THE PLANNER

WHAT JUST HAPPENED

▸  The logic change has no basis in reality — the sequencing constraint still exists on site.

▸  The delay hasn't gone away. It has been hidden inside the revised logic.

▸  When the trades clash on site and cladding has to stop, the delay reappears — and now looks like a new event.

▸  The original constraint existed in Month 2. 

The contractor calls you. 'Don't worry 
we've re-sequenced the work. 
Cladding can now run in parallel with 
fit-out. We've recovered the program.' 
The updated schedule shows 
completion back on time. You pass 
this on to the client.

You're told to 'find some recovery.' You 
open the schedule and change the 
Finish-to-Start link between cladding 
and fit-out to a Start-to-Start with a 
5-day lag. On paper, 3 weeks of delay 
vanishes. The schedule shows green. 
But those two trades can't actually 
work in the same area simultaneously.

You own the cladding package, you 
know the two trades can't run 
simultaneously from prior experience, 
and can already see the on-site 
collision coming in Month 5

YOU ARE THE CAM
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04. The Core Problem: Scope Changes

YOU ARE THE PM

W H A T  J U S T  H A P P E N E D

WH A T  J US T  H AP P E N ED

YOU ARE THE PLANNER

WHAT JUST HAPPENED

▸  50 new activities have been used as invisible buffers — absorbing delay without declaring it.

▸  The PM sees no change in completion date and reports to the client that the project is on track.

▸  None of these new activities appear in the original baseline — the schedule has fundamentally changed.

▸  A comparison of activity counts between periods is one of the simplest manipulation red flags to spot.

You compare this month's schedule to 
last months. It has grown from 380 
activities to 430. The contractor says 
the extra activities are 'just more 
detail.' The completion date hasn't 
moved. You assume that's a good 
sign.

You've inserted 50 new 'procurement' 
and 'inspection' activities between 
existing tasks. Each one absorbs a few 
days of the delay that had been 
building. Split across 50 new activities, 
the delay is invisible. Completion date: 
unchanged. Problem: solved on 
paper.

You now have 12 new phantom 
activities inserted into your sequence 
and are being asked to status them 
every fortnight.

YOU ARE THE CAM
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05. The Core Problem: Baseline Drift

YOU ARE THE PM

W H A T  J U S T  H A P P E N E D

WH A T  J US T  H AP P E N ED

YOU ARE THE PLANNER

WHAT JUST HAPPENED

▸  12 months of small revisions have made the original program unrecognisable.

▸  No single change was large enough to challenge — but the cumulative effect is enormous.

▸  A retrospective delay analysis is now near-impossible — the forensic trail has been erased.

▸  This is the most common situation facing delay analysts on major projects at final account stage.

It's Month 10. The client asks for a delay 
analysis going back to Month 1. You 
pull up the old schedules except the 
'baseline' stored in the schedule has 
been quietly re-baselined three times. 
Month 1's logic barely resembles what 
was originally submitted. You have no 
idea what was planned.

Each month you've made small 
tweaks a duration here, a link there. 
Nothing dramatic, nothing that 
needed signing off. Over 10 months 
those small changes have 
accumulated. The schedule 
submitted today shares a name and 
structure with Month 1, but the logic is 
completely different.

You signed off a 90-day work 
package in Month 1 by Month 10 the 
baseline shows 75 days, and you 
never approved this change

YOU ARE THE CAM
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  A U D I E N C E  P O L L

Which schedule revisions
have YOU seen on your projects?

Write as many as you can think of

Go to menti.com and enter code
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  A U D I E N C E  P O L L

Which schedule revisions
have YOU seen on your projects?

Write as many as you can think of

Go to menti.com and enter code
Write as many as you can think of
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The Skeiny Way — The Seven-Step Process

A structured, repeatable method for schedule delay analysis from the first conversation with the client through 
to visualised output.

01
Identify Project Focus Areas & Client Outputs
Define key milestones, risk zones and reporting 
obligations before touching any data

02
Ingest Data & Snapshots
Gather all files (XER, MSP, OPP) and understand data 
availability, limitations and key field changes.

03
Run Analysis Tools to Identify Delays
Acumen Fuse (health & forensics), Steelray (Half-
Step & comparison), set up scheduling 
environments.

04
Complete Detailed Analysis
Float path analysis, construction lookahead 
techniques, near-critical path and sequence 
review.

05
Summaries into Change Register
Document all delays and revisions duration, logic, 
constraints, risk attribution into one register.

06
Review & Collaborate
Bring in project team knowledge. Distinguish real 
delays from scheduling logic artefacts.

07
Lookahead & Visualise
Identify relevant WBS elements for tracking, 
produce the high-level lookahead and visualise the 
results.
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The Skeiny Way — The Seven-Step Process

A structured, repeatable method for schedule delay analysis from the first conversation with the client through 
to visualised output.

01
Identify Project Focus Areas & Client Outputs
Define key milestones, risk zones and reporting 
obligations before touching any data

02
Ingest Data & Snapshots
Gather all files (XER, MSP, OPP) and understand data 
availability, limitations and key field changes.

03
Run Analysis Tools to Identify Delays
Acumen Fuse (health & forensics), Steelray (Half-
Step & comparison), set up scheduling 
environments.

04
Complete Detailed Analysis
Float path analysis, construction lookahead 
techniques, near-critical path and sequence 
review.

05
Summaries into Change Register
Document all delays and revisions duration, logic, 
constraints, risk attribution into one register.

06
Review & Collaborate
Bring in project team knowledge. Distinguish real 
delays from scheduling logic artefacts.

07
Lookahead & Visualise
Identify relevant WBS elements for tracking, 
produce the high-level lookahead and visualise the 
results.

Real 
life
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The Skeiny Way — The Seven-Step Process

A structured, repeatable method for schedule delay analysis from the first conversation with the client through 
to visualised output.

01
Identify Project Focus Areas & Client Outputs
Define key milestones, risk zones and reporting 
obligations before touching any data

02
Ingest Data & Snapshots
Gather all files (XER, MSP, OPP) and understand data 
availability, limitations and key field changes.

03
Run Analysis Tools to Identify Delays
Acumen Fuse (health & forensics), Steelray (Half-
Step & comparison), set up scheduling 
environments.

04
Complete Detailed Analysis
Float path analysis, construction lookahead 
techniques, near-critical path and sequence 
review.

05
Summaries into Change Register
Document all delays and revisions duration, logic, 
constraints, risk attribution into one register.

06
Review & Collaborate
Bring in project team knowledge. Distinguish real 
delays from scheduling logic artefacts.

07
Lookahead & Visualise
Identify relevant WBS elements for tracking, 
produce the high-level lookahead and visualise the 
results.
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06. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

feb mar apr may jun jul aug sep oct nov dec

A half-step analysis first applies only the progress-related changes to the schedule and observes the 
causes of delays.
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07. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

+3 days

Activities

A
B
E

feb mar apr may jun jul aug sep oct nov dec

One approach: apply all the changes one-by-one.
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08. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

±0 days

feb mar apr may jun jul aug sep oct nov dec
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09. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

🗎
Half 
Step

feb mar apr may jun jul aug sep oct nov dec



© 2026 Skeiny. All Rights Reserved

Skeiny
Sched

ule W
ithout Revisions

18

10. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

🗎
Half 
Step

+3 days -3 days

feb mar apr may jun jul aug sep oct nov dec
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11. What is a Half-Step Analysis?

🗎
Window 

Start

🗎
Window 

End

🗎
Half 
Step

+3 days -3 days

Activities

A
B

Activities

C

feb mar apr may jun jul aug sep oct nov dec

Completed 
activities remain as 
per completion 
dates

Incomplete remain 
as per their prior 
planned
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13. Half-Step Analysis Fact Check

Why is Half-step analysis worth it?

➢ It is not predisposed to one side (owner or contractor). 

➢ It goes much further than schedule comparison reports 

by showing the reasons for finish-date delays. 

➢ It goes deeper into the behaviour of the critical and 

longest paths between updates.

Why Is a Half-Step Analysis So Difficult?

A Concurrent and pacing delays and recoveries

B Both delays and recoveries, some extending across 
update periods.

C Out-of-sequence execution

D Retained logic vs. progress override scheduling

E Multiple work calendars



© 2026 Skeiny. All Rights Reserved

Skeiny
Sched

ule W
ithout Revisions

21

03. The Skeiny Way — Steelray Delay Analyser Report
Steelray's Delay Analyser produces a period-by-period report of delays and schedule revisions across all 
submitted programs.

HOW TO RUN IN STEEL RAY

1
Load all period files
File → Open → load XER files for all periods in 
sequence. Steelray will order them by data date.

2

Select Delay Analyser
Analysis → Delay Analyser → Configure. Set the 
target milestone (project completion or sectional 
completion).

3

Set analysis parameters
Choose comparison type: period-over-period or 
against the baseline. Set the float threshold 
(recommend 0 for critical path focus).

4

Run and review
Steelray produces a table: each period, delay 
accrued, activities responsible, and whether the 
delay is on the driving path.

5
Export report
Reports → Delay Analysis → Export. This report feeds 
directly into the Change Register

WHAT THE REPORT REVEALS

  Which periods had the most delay accrued and 
which activities drove it

  Where schedule revisions masked delay: duration 
compressions, logic changes, new activities added

  Where genuine recovery occurred versus 
manufactured float recovery

  Whether the delay was on the critical / longest path 
or on a near-critical path that later became critical

  The revision history for each activity, every change 
across all periods in one place

  A foundation for risk attribution, which delays were in 
the contractor's control, which were not

OUTPUT:  A Steelray Delay Analyser covering all submitted periods — delays identified, revisions catalogued, driving path 
confirmed.
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Tools: Acumen Fuse
& Steelray03
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01. Acumen Fuse — How to use it: Import & Quality Check

Start every monthly review by loading the contractor's file and running the automated quality gate before any 
delay analysis begins.

1
Import the Schedule File
File → Import → select XER (P6) or BK3/XML (OPP).
Acumen reads the file and displays an import summary — check total activities, data 
date, and baseline status before proceeding.

 Always verify the data date 
on import matches the 
contractor's submission letter 
date.

2
Run the DCMA 14-Point Health Check
Metrics → DCMA 14-Point → Run.
Each of the 14 checks returns Pass, Warning, or Fail with a drill-down list of the specific 
activities causing each failure. Export this as a PDF — it is your formal non-
conformance evidence.

 More than 3 Fail results = 
consider rejecting the 
submission and requesting a 
corrected resubmission in 
writing.

3
Run Float Path & Near-Critical Analysis
Metrics → Float Path → Configure Bands → Run.
Set the near-critical threshold to 20 working days. Acumen ranks all float paths from 
most critical outward. Path 1 = driving critical path. Paths 2–10 = near-critical risk 
zones. Note any path whose float is trending downward month-over-month.

 A path dropping 5+ WD of 
float per period without 
recovery is your next delay in 
the making.
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02. Acumen Fuse — How to use it: Forensics & Comparison

4
Run the Forensic / Half-Step Calculation
Forensics → New Analysis → set Period Start and Period End to the data date → Run.
Acumen freezes the schedule at the data date, splits in-progress activities (Half-
Step), and calculates the predicted Early Finish for every milestone. It then compares 
to the prior period automatically — Period Delay = EF(now) − EF(last month).

 Save the Acumen project 
file (.acumen) for this period. It 
preserves all settings for the 
forensic archive.

5
Run the Scenario Comparison
Scenarios → Add Scenario → load the previous period XER → Compare.
Acumen shows a side-by-side diff: every activity where a date, duration, or logic link 
changed between the two periods. Flag activities where Total Float increased without 
a scope change — these are your manipulation candidates.

 Filter by 'Float Increase > 5 
WD' to isolate artificial float 
generation instantly.

6
Export Findings & Update the Delay Register
Reports → Schedule Health → Export PDF  |  Reports → Forensics → Export PDF.
Issue the health report to the contractor as formal schedule review correspondence. 
Extract the Period Delay figure into your monthly delay register with the risk attribution 
(Contractor / Employer / Concurrent) and any notice obligations triggered.

 A consistent monthly PDF 
trail from Acumen is 
contemporaneous evidence — 
far stronger than any 
retrospective reconstruction.

ACUMEN WORKFLOW COMPLETE: Import → DCMA → Float Path → Forensics → Compare → Export  ·  Total time on a 2,000-activity schedule: ~45 
minutes
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03. Example comparison point

Feb 25 – Dec 25

Feb 25 – Dec 25 – Half Step

Feb 25 – Dec 25

Feb 25 – Dec 25

Feb 25 – Dec 25 – Half Step

Feb 25 – Dec 25
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04. Steelray – How to Use It: Load, Health Check & Compare

Steelray's strength is speed and breadth — it reads any schedule format, produces audit-ready PDFs, and 
generates a complete revision change log in minutes.

1
Open the Schedule File
File → Open → select XER (P6).
Steelray validates the file on load and flags any import issues. No P6 licence or server 
connection required — works standalone on a laptop.

 For OPP: export via File → 
Export → XML (Scheduling 
Exchange Format) in Open 
Plan before loading into 
Steelray.

2

Run the Period Comparison
Analysis → Compare Schedules → load current period + previous period → Run.
Steelray generates a full change log: activities added, deleted, duration changes, 
logic link changes, constraint changes, and date shifts. Sort by 'Float Change' to 
surface activities where float has increased without justification — your manipulation 
checklist.

 Save the comparison report 
alongside the native files. 
Together they are your month-
by-month forensic archive.
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05. Steelray – How to Use It: Float Path, Forensics & Reporting

Once the quality check and comparison are complete, use Steelray to trace the critical path, quantify slip, and 
produce the formal report package.

3

Trace the Critical Path & Float Trends
Analysis → Critical Path → Trace from Completion Milestone.
Steelray traces the full driving path backwards from the project completion activity. 
Switch to Analysis → Float → Float Distribution to see how float is spread across the 
schedule. The Float Trend report shows each float path's value over all loaded periods 
— a path with consistently reducing float is your leading risk indicator.

 Load 3–6 months of XER 
files at once to generate a 
multi-period float trend chart 
automatically.

4
Run Milestone Slip Analysis
Analysis → Milestones → select key contract milestones → Compare Periods.
Steelray calculates the slip for each milestone between the current and prior period — 
equivalent to the Half-Step delta. Use this as your period delay figure. For each 
milestone: Planned Finish, Current Predicted Finish, Slip in calendar days.

 Cross-reference the slip 
figure with the float path trace 
to confirm the delay is on the 
true driving path, not a non-
critical activity.

5

Export the Formal Report Package
Reports → Export Excel → select: Health Report, Comparison Report, Float Trend, 
Milestone Slip.
All four reports combine into a single Excel package. This is designed to attach directly 
to your monthly schedule review correspondence to the contractor — no formatting 
work required. Each report shows schedule name, data date, and run timestamp.

 File the Excel alongside the 
native XER file in your period 
archive folder. Together they 
are a complete 
contemporaneous record.

STEELRAY WORKFLOW COMPLETE: Open → Health Check → Compare → Float Trace → Milestone Slip → Export PDF  ·  Total time: ~30 
minutes
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06. Steelray - Applications
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06. Steelray - Applications
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06. Steelray - Applications
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  A U D I E N C E  P O L L

What would stop you from using this 
approach??

Select all that apply – be honest!

Go to menti.com and enter code

Select all that apply – be honest!
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Fun Ways to See
Delays Visually04
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01. Visual Delay Analysis Techniques
The best schedule analysis is worthless if no one understands it. Visuals tell the story.

Milestone Trend Analysis (MTA)

A simple line chart: X axis = reporting period, Y 
axis = predicted completion date. A rising line = 
ongoing delay. Instantly communicates project 
trajectory to executives.

 The scarier it looks, the better — clients 
understand this one!

Delay Waterfall Chart

Stacked bar chart showing cumulative delay 
broken down by risk category (Contractor, 
Employer, Concurrent, Neutral). Shows who 'owns' 
the delay visually.

 Colour-code by party — makes disputes 
uncomfortably obvious.

Float Consumption Heat Map

A heat map across the Gantt: activities coloured 
by float remaining. Green = healthy, amber = at 
risk, red = critical. Immediately shows where the 
schedule is burning.

 Looks like a fire spreading — very effective in 
presentations!

As-Planned vs As-Built Gantt Overlay

Dual-bar Gantt showing original plan (above) 
and actual/predicted (below) on the same time 
axis. Arrows connecting slipped activities make 
delay causation tangible.

 Lawyers love this — you can literally point to 
the gap.
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02. Milestone Trend Analysis Chart

READING THE
MTA CHART

Rising line:
= project falling further behind 
each period
Flat line:
= project tracking — no new 
delays accruing
Falling line:
= genuine recovery being made

Step change:
= discrete event (VO, weather, 
etc.)
Gradient:
= rate of delay accrual

Simple. Undeniable.
No engineering degree required.

Reference for the chart: Steeray Brian’s PPT
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03. Float Consumption Heat Map – Milestone Tracking

Track each milestone's planned start, planned finish, current start, current finish, and float remaining — coloured by risk level.

Critical  (TF ≤ 0) High Risk  (TF 1–5) At Risk  (TF 6–15) Healthy  (TF 16–30) Comfortable  (TF > 30)

Milestone
Plan
Start

Plan
Finish

Current
Start

Current
Finish

Start
Slip

Finish
Slip

Float
Remain

Foundations Complete 02 Jan 28 Feb 02 Jan 14 Mar 0d +14d 12

Structure Topping Out 01 Mar 30 Apr 18 Mar 28 May +17d +28d 5

Facade Enclosure 01 May 30 Jun 02 Jun 18 Jul +32d +18d 8

MEP Rough-in Complete 15 May 31 Jul 20 Jun 25 Aug +36d +25d 3

Fit-Out Level 1–3 01 Jul 30 Sep 05 Aug 31 Oct +35d +31d 0

Fit-Out Level 4–6 01 Sep 30 Nov 10 Oct 15 Jan +39d +46d -7

Building Commissioning 01 Nov 31 Dec 15 Dec 10 Feb +44d +41d -12

Practical Completion 31 Dec 31 Dec — 01 Mar — +60d -21

Red rows = critical or negative float. Orange = high risk. Reading across each row shows the full drift picture — start slip, finish slip, and remaining float in one view.



© 2026 Skeiny. All Rights Reserved

Skeiny
Sched

ule W
ithout Revisions

36

04. As-Planned vs As-Built / Predicted – Gantt Overlay

Foundations

Structure

Facade

MEP Rough-in

Fit-Out L1-3

Commissioning

J F M A M J J A S OActivity
Data
Date

Blue bars = original plan  ·  Coloured bars = current predicted  ·  Arrows = the slip  ·  Red = significant delay  ·  Dashed line = 
today's data date

Each activity shown twice: planned bar (above, blue) and current predicted bar (below, coloured by delay 
severity). Arrows show the slip.

As-Planned

On Track / Early

Minor Slip (<14d)

Significant Slip (>14d)

N D

PC Milestone

SLIP
SUMMARY

Foundations +14d

Structure +28d

Facade +18d

MEP +25d

Fit-Out +31d

PC +60d

N
N

D
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05. Cumulative Delay – Stacked Waterfall by Cause

-15

-5

5

15

25

35

45

55

65

75

Jan Feb Mar Apr May Jun Jul Aug Sep Oct

Foundations overrun (Contractor)

Employer Design Change — VO 001

Late Information — RFI 047

MEP Coordination Delay (Contractor)

Facade Procurement (Contractor)

Employer Scope Addition — VO 014

Recovery (Contractor acceleration)

Cumulative
Total: +60d

Green segments = contractor acceleration / recovery. Each colour traces back to a specific event — making the delay story transparent and attributable.

Each colour represents a different delay event. Stacked bars show how individual causes have built up to the total cumulative 
delay at Practical Completion.
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  A U D I E N C E  P O L L

What would stop you from using this 
approach??

Select all that apply – be honest!

Go to menti.com and enter code

Pick One
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